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Overview
Yacht-Z is a version of the classic dice game.    Now, in addition to triple scoring, single 
scoring is added for quicker, simpler games.    Due to popular request, up to four players 
can now play at one time.    A new, chiseled look has been given to all windows and dialogs.

The basic premise of the game is to roll five dice up to three times to achieve the highest 
score using the standard scoring grid.    The specifics of scoring will be explained in the text 
that follows.    If you are familiar with the classic game, then you already know how to play.



Playing Yacht-Z
When you open Yacht-Z, two windows will be visible.    They are the Dice window and a 
Scorecard. At this point a game is ready to be played.    Many aspects of the game play can 
be setup from the Options menu.    The selections available are described as follows:

Show Hints: toggle the hints display (described below).

Single Yacht-Z: toggle the game type between single and triple mode.    In triple 
mode, there are three columns to place scores into.    The example below describes this 
type of game.    Single mode has only one column of scores.

Hide Other Cards: If this item is checked, only the current scorecard will be 
displayed.    The others will be hidden until they become current.

No. of Players: choosing this selection will bring up a dialog box allowing the user 
to set the number of players (1-4) that will be playing.

Change Luck: This menu item is provided for those times when things just don't 
seem to be going your way.    If you register and ask, I will tell you how it works (however, it 
may be just a placebo!).

Some of the selections in the Options menu can be accessed while a game is being played. 
The No. of Players and Single Yacht-Z items are grayed out since they would change the 
format of any game in progress.

Open the File menu and select New Game.    The game windows are opened and drawn.    
These windows are:

Dice: The five dice are shown and controlled here.    To roll them press the Begin 
button.    Dice will roll when their 'backs' are shown (as is the case before the first roll) or 
when one or more dice are selected.    After the third roll, the Begin button indicates Done.   
Below the control button are the scores for all players.    This is helpful when any of the 
scorecards are obscured by others.

Scorecard: All scoring is done here.    Scoring is described in the following section.

Example Game

Probably the best way to describe how to play Yacht-Z is to provide a walk-thru.    Once all 
three windows are showing, press the Begin button in the Dice window.    If the dice tumble 
too slowly for you, open the File menu and select the Show Roll item.    This will cause the 
dice to rapidly update.    Open this menu again and assure that the Show Hints item is 
checked.    When a menu item is checked, it means that the function referred to is enabled.  
If there is no check shown, the function is disabled.

The condition of the Scorecard after a roll depends on the values on the dice.    Since we 
turned on Show Hints, the scorecard will show in black the items which will yield points if 
selected.    All others will be disabled (shown in gray).    You may place a score in any item, 
but if the combination of the dice does not match, you will receive zero points in that box.    
If Show Hints is not enabled, all scoring categories will be shown in black throughout the 
game.

However, since this was the first roll, there is no reason to select a scoring category quite 
yet.    You may select on any roll, but after the third roll you MUST select a scoring category 



(even if it is invalid).

To initiate a roll after the first roll, select which dice will be rolled again by clicking on them 
with the mouse pointer and pressing the Begin button.    If you make a mistake selecting a 
die, it can be corrected by clicking on it once again, which results in turning the selection 
off.    Try this by clicking twice on a die.

When you have selected a scoring category, the dice faces are replaced by the diceback 
design and the Undo! menu item becomes enabled for the first time.    This allows you to 
take back the scoring placement just made.    If you press it, the score is removed and the 
dice faces are restored.    You are now in the same position as before the scoring selection 
was made.    If you have another roll left you can highlight dice and roll again, or place the 
score in a different category.

When playing triple Yacht-Z, the scoring buttons are arranged in three columns.    This is the
essence of the triple scoring method.    The total of the left most column is multiplied by 
one, the second column is multiplied by two and the third column is multiplied by three.    
The totals of all three columns is combined to make up the Grand Total, which is your final 
score.    In single Yacht-Z, there is no score multiplying done, and there are fewer buttons to
press, which results in a quicker game.

The Scorecard is divided into four sections:    The top section comprises the matched value 
scoring.    If you have two fours showing on the dice and select a button on the Fours row, 
you would score eight (8) points on that button.    Only the dice matching the rows type are 
totaled in the first section.    The second section is the total area for the Upper section.    The
total of each column is shown in the Total row.    If this value is 63 or greater, a bonus of 35 
points is awarded and shown on the Bonus row.    The last row of the second section shows 
the Upper section total and is made up of the Total and Bonus rows.

The lower section begins with a portion showing scoring categories based on special 
sequences or combinations using different scoring methods:

Three of a Kind: If 3 or more of the dice match, the total of all dice is entered.

Four of a Kind: If 4 or more of the dice match, the total of all dice is entered.

Full House: If 3 of one face and 2 of another are shown on the dice, then 25 points 
is awarded.

Small Straight: If 4 consecutive values ( i.e. 1,2,3,4 ) are shown then, 30 points is 
awarded.

Large Straight: If 5 consecutive values ( i.e. 1,2,3,4,5 ) are shown then, 40 points 
is awarded.

Yacht-Z: If all dice are of the same value, 50 points is entered into the selected 
button.    If you are fortunate enough to get more than three Yacht-Z's, additional five-of-a-
kind combinations will be recorded in the Yacht-Z Bonus category (worth 100 points), 
starting in the leftmost column.    You must place the score into a valid category to receive 
this bonus (i.e. Four of a Kind).    Note that this only occurs when playing triple Yacht-Z.

Chance: The total of all dice is entered.    This is useful if the values of the dice are 
high, but are not applicable on any other button.    Some versions of the game require you 
to a play if possible and only use the Chance button as a last resort.    Yacht-Z does not 
impose this restriction ( where's the fun in that? ).    The Chance button can be used at any 



time.

The fourth section of the Scorecard is where your total score is computed.    The exact 
layout of this section is determined by the type of game you are playing.    If you are 
playing Single Yacht-Z, then only two totals are shown here: the Lower Section Total and the
Combined Total, which is your final score.    For a Triple Yacht-Z game, there are additional 
portions of this section.    The Lower Section Total is added to the Yacht-Z Bonus to give you 
a Combined Total.    Then this total is multiplied by the column it is located in to yield a 
Grand Total, which is your final score.    This sounds more complex than it is.    Try playing 
and you'll see how it works.

Game play continues until all playable buttons have a score in them.    At this point the 
'Game Over' dialog will appear.    If a Combined Total (Grand Total in triple scoring) is among
the ten highest, that player will be prompted for their name.    This will be placed in the 
High Score list with the date and score, in it's appropriate position.    To play again, select 
New Game from the File menu.

Notice that it is possible to save a game in progress by selecting the Save Game item from 
the File menu.    Any game which is saved can be restored at a later time by selecting the 
Load Game item from this same menu.

High Scores: The ten best single and triple scores are kept on disk along with the 
player's name and the date the game was played.    These scores are shown in the drop 
down menu labeled High Scores.



Strategy
There are as many strategies to playing Yacht-Z as there are players.    Every one in the 
beta-test of Yacht-Z developed their own methods to reaching the highest score possible.    
All were correct.    There are, however, several undisputable guidelines to follow:

-    When in doubt, always go for a Yacht-Z!
- Fill in the third column with your best scores first.
- Use combinations in Upper section first to get Upper Bonus.



Registration
Yacht-Z    is Copyright 1990, 1991, 1992, 1993 by Bob Dolan, All rights reserved.

Yacht-Z is distributed as shareware.    This means that if you regularly use the product and 
benefit from it, you should register with the author (address below).    The software you now
have is not crippled in any way.    This indicates a basic trust of the shareware concept by 
myself and other shareware authors who provide useful products with the hope of some 
type of return for their efforts.    Basic registration is $10.

If you are a shareware author, register by sending a registered version of your product to 
me.

Please print the registration form and fill in the requested information.    Mail it with a check 
or money order in U.S. funds and made payable to Bob Dolan to this address:

Bob Dolan
P.O. Box 16514
Rochester, New York 14616

------------------------------------------------------------
A big THANK YOU! to all of you who have taken the time to register Yacht-Z with me.    You 
now own this version as well and all future versions of Yacht-Z.    I appreciate your letters 
very much.
------------------------------------------------------------

Distribution

If you distribute Yacht-Z      to friends, associates, or to a computer bulletin board system 
(BBS),    you may only distribute the compressed file including the copyright and disclaimer.

Disclaimer

The Copyright Owner hereby disclaims all warranties relating to this software, whether 
express or implied, including without limitation any implied warranties of merchantability or
fitness for a particular purpose. The Copyright Owner will not be liable for any special, 
incidental, consequential, indirect or similar damages due to loss of data or any other 
reason, even if The Copyright owner or an agent of The Copyright Owner has been advised 
of the possibility of such damages.    In no event shall The Copyright Owner's liability for 
any damages ever exceed the price paid for the license to use the software, regardless of 
the form of the claim. The person using the software bears all risk as to the quality and 
performance of the software.



Update History
Version 1.01 -- December 14, 1990

Ooops! A late bug report concerning High score handling caused this fix.    In 
addition child windows are not closable using the F4 key now.    This caused some other 
obscure problems, which are now avoided.

Version 1.10 -- June 4, 1991
Moved High Score handling into a new menu item.    Eliminated the High Score 

window.    This made the main window requirements smaller, so its width has been reduced 
to 60% of the screen.    Hopefully any high score handling bugs are gone with this release.

Undo handling is now complete.    All scores are updated at Undo time rather then 
when the score handler gets around to it.    Undo handling is much more reliable.

The dice selection handling has been improved.    They were a bit sticky, and are 
now less annoying to use.

The pushbutton in the Dice window is now instructional.    It shows the current turn, 
as well as Begin and Done at the appropriate times.

There has been some interest in a 2 player version of Yacht-Z.    If this gets 
substantial, I will add that capability.    The only problem is that it takes up a lot of the 
screen.

Version 1.20 - 1.28 -- Unreleased versions

Version 1.30 -- October 31, 1991
Added Load Game and Save game menu items to File Menu.    Some code 

optimization.

Version 2.00 -- October 31, 1992
Added multi-player capability.
Added Single scoring capability.
Added Hide Other Cards menu item.
Added Change Luck selection.
Removed Show Roll feature.
Removed Set Names dialog.    Names are taken after games.
Implemented COMMDLG.DLL for Load/Save game dialogs.
Implemented Borland BWCC.DLL for custom controls in dialogs.

Version 2.10 -- March 20, 1993
Fix bug that did not allow Yacht-Z Bonus to be awarded (a rare event!)
Added online Help system, which you are now reading. Removed WRI file.

Version 2.20 -- May 1993
When the program starts, a new game is ready to play immediately.
P.O. Box is added to my address.

Version 2.21 -- June 1993
Fixed a reported bug where the last player to play was always shown as the winner 

in the playing card caption.    This was noticable only in multi-player games.
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Registration Form
To print this registration form, open the File menu and select Print Topic.

Please register me as a satisfied user of Yacht-Z (ver 2.21):

Amount Enclosed: 
                                  $10 [    ]    Registration No disk included      

                                  $15 [    ]    Register w/upgrade. [    ]3.5      [    ]5.25

Please note that 720K 3.5 disks will be used unless you request otherwise.
For orders from outside of the U.S., please add $3 to cover additional postage.

Can you UNZIP files?    Yes________    No________

Name:_____________________________________________________

Address:___________________________________________________

City:______________________State:_______Zip:__________________

Phone(optional):_____________________________________________

GEnie/CompuServe/Internet mail address:_______________________

Where did you get Yacht-Z?___________________________

___________________________________________________________

Comments:_________________________________________________

___________________________________________________________

___________________________________________________________

___________________________________________________________

___________________________________________________________



Other Products from Bob Dolan
DeskMenu --    A slimmed down Program Manager for Windows
Version 1.20 - May 1993

An efficient replacement or addition to the Program Manager.    Provides a menubar at the 
top of the Windows desktop with menu headings defined by you to represent the categories
of applications you typically need to access.    A simple interface allows you to customize 
the look and feel of this useful system utility.

Shareware.........$10

WinGo! --    The classic Bingo for Windows
Version 1.0 - May 1993

Finally Bingo has arrived for Windows!    You match wits with Rosie, an alert and cunning 
adversary.    You can play with as many cards as you can handle at the speed you like.    
Fully configurable to adapt to your playing style.    The registered version includes digitized 
voice calling for the most realistic Bingo play possible.

Shareware.........$10

WinDial -- A    Windows Phone Book that dials
Version 1.0 - May 1993

An easy to use phone book that will automatically dial any selected number as long as you 
have a modem.    When a busy signal is detected, you can tell WinDial to retry until 
someone answers.    Other busy attempts can be placed into a queue, and all will be retried 
in order.

Shareware.........$10

Mister Clean
Version 1.00 -- March 1993

One of the most efficient ways to clean up those hidden but unwanted or unused files that 
take up needed space.    A slick Windows 3.x user interface makes this utility a must have 
for your toolbox.    Mister Clean finds the files you specify and sorts them by size.    You click 
on the ones you want deleted and then off they go, one-by-one (to be safe) or all at once.    
Not sure what the file is?    Then run it right from Mister Clean and check it out before 
dumping it!    Truly a unique way of managing precious disk space.

Shareware.........$10

<softWAREhouse> A warehouse for all of your software
Version 1.00 -- January 23, 1993

<softWAREhouse> provides your system with the ability to access more applications than it
can hold at one time.    This is made possible by storing installed applications offline until 
they are needed.    When required, they are put back on the user's machine in the same 
condition and location as they were when originally stored.    All of this power is surrounded 
by an easy to use point and shoot menu interface.



Shareware.........$15

Yacht-Z    --    A dice strategy game for Windows 3.X
Version 2.21 -- June 1993

Yacht-Z is a version of the classic dice game.    Now, in addition to triple scoring, single 
scoring is included for quicker, simpler games.    Due to popular request, up to four players 
can now play at one time.    A new look to all dialogs gives the program new life in the world
of Windows 3.1

Shareware.........$10

BattleGrid -- War in a window -- Battleship for Windows 3.x
Version 2.0 -- May 1993

BattleGrid is a version of the classic board game.    Play against the computer or another 
person.    Watch the computer play against itself using different strategies.    Several levels 
of a computer opponent are available, from idiot to genius.    

Shareware.........$10

MagnaFile 
Version 2.2 -- October 1992

MagnaFile is a DOS shell which is directed at a wide range of users from the DOS beginner 
to the most prolific DOS power users. MagnaFile provides services to the user to simplify 
access to DOS.    It also increases the efficiency of doing many of the more tedious 
operations DOS requires.

MagnaFile commands are carried out using a one-key interface.      Most operations are 
associated with a very obvious key, such as <C> for the Copy command.

The most useful utilities provided by MagnaFile are:

                For Single Files or Groups of Files:
                        Copying
                        Moving
                        Deleting.
                        Attributes
                        Printing

                File Descriptions (40 characters)
                File Viewing & Editing
                File execution
                Disk navigation
                File & Directory Renaming

                File Archiving, Unarchiving, and Archive viewing
                Command line interface
                Mouse handling
                Screen saver and password protection



                Run programs from a smart menu interface
                
MagnaFile is similar to Norton Commander(NC). Users of this product say that MagnaFile 
will be an important tool on your computer, no matter what level user you are.

Shareware..........$20

Smart Solitaire
Version 1.01 -- November 9, 1989

A text mode klondike solitaire card game which uses the mouse.    Features BOSS mode and
smart playing features, such as automatic card placement in obvious situations.    Very 
addicting and fun!

Shareware.........$10

                                                    FreeWare
VLINES Version 1.0 - May, 24 1990

VLINES is a flying lines demo that runs on VGA adapters.    It can produce some interesting 
moire patterns as well as brilliant color combinations.

TCAL Version 1.0 -- June 24, 1990

The TSR Calendar (TCAL) is a resident popup calendar which is useful for viewing any 
month of any year by controlling the PgUp, PgDn, and arrow keys.

Laser Fireworks Version 1.0 - August 11, 1990

Laser Fireworks is a pyro like demo program which utilizes lasers having the effects of 
fireworks.    Hard to explain, fun to watch!

Phone BaseVersion 2.0 --    November 8, 1990

Phone Base is a program that includes a small dedicated database with just two fields.    
Any two field database requirement you have can be filled by Phone Base.    However, the 
primary intention of this application is the storing and dialing of phone numbers.

DcDVersion 1.1 -- October 1991

DcD is a utility to assist DOS users in moving about a Hard disk drive directory structure.    
When you run DcD, it scans your disk and builds a tree which reflects the directory 
relationships that exist.    Once this is done, DcD can present you with this tree, displayed in
a graphical nature.      You may move a cursor to other directories and change to them by 
pressing the <Enter> key.

TLinesVersion 1.0 -- October 1991

A moving lines demo, similar to VLINES, this program runs in text mode and draws lines 
using several types of text characters.

FreeViewVersion 1.0 -- October 7, 1991



FreeView is a hex or text file viewer.    FreeView provides text searching functions and can 
handle files up to 5000 lines in length.

IdleVersion 1.0 -- October 1991

Idle is a text mode screen saver, which will display a message you specify.    The message is
shown in a box which moves around the screen until a keystroke interrupts it.    The user is 
returned back to DOS if the correct password is entered.    All parameters are user specified.

StarzVersion 1.0 -- October 1991

A user controllable starfield.    If a mouse is connected, the user can steer the display.    
Occasional speed changes and swirls make this an interesting screen saver.

BackYard FootballVersion 1.00 -- November 16, 1991

A DOS text mode real-time football game for one or two players.    Modeled after the old 
hand held football games.    Complete running stats, and challenging control of passing, 
running and kicking make this a fun game.    Games can be saved and loaded in progress.




